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Using Gateway

This online resource or rural health research connects you to:

* Research and Policy Centers

* Reports & Journal Publications
* Fact Sheets

* Policy Briefs

* Research Projects

*  Email Alerts

* Experts

* Dissemination Toolkit
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Browse Research Rural Healtn Researcn Gateway > Topes
Additional Resources

Topics Quality
— Access othor FORHP-funded

! Projects on this Topic resources on this fopic.
Products & Publications The Centers have 5 research projects currently underway to explore this issue. From the Flex Monitoring Team:

In the past, 53 research projects have been completed on this topic + Community Beneft Publcations

- « Flex Program Publications
Research Findings

« Hospital Compare Publications
View publications, including policy briefs, working papers, and final reports, on
{his topic * MBQIP Publications

« Patient Satety Publications

« Journal Artcles - (3) « Payfor-Performance Publications
« Qualty Publications

From the Rural Health Information

« Rural Healthcare Quality Topic
Guide

Rural Health Research Gateway
Provide access to publications and projects funded through FORHP

* Aim to reach diverse audiences
* Make Gateway a resource for:
* Students

* Policy Makers
* Other Health Researchers
* Rural Health Providers

* Rural Health Professionals/Organizations/
Associations

https://www.ruralhealthresearch.org
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Rural Health Research Gateway

The Rural Health Research Gateway provides easy and timely
access to research conducted by the Rural Health Research
Centers, funded by the Federal Office of Rural Health Policy.
Gateway efficiently puts new findings and information in the hands of
our subscribers, including policymakers, educators, public health
employees, hospital staff, and more.

Rural Health Research Gateway.

« Gateway Flyer
« Leam more
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Centers esearch Alerts Current Projects esearch Products issemination
» Leam about the Rural + Email notifications when « Leam about research « Access free policy briefs, oolkit

A AboutUs Browse Research Webinars ~ Research Alerts  Other Rural Research
p— More from the Research
pes Rural Health Research Products Centers
Projects The full st of freey-available eseatch prodcts ffom the Rural Heath Research
Centers, including policy briefs, reports, chartbooks, interactive data websites, Alistof joumal afcles appearing in
P EORETS posine ing policy: o peer-reviewed publications is also

avalable. (Access may be restricted.)
Browse Research Products:
« By Date

« By Topic Subscribe to Research Alerts

+ B Research Center Sign-up to receive email notfications
Five Most Recent Research Products :Z‘:’;‘:z;'ese“" products are
+ The Financial Importance of the Sole Community Hospital Payment

Designation

North Garolina Rural Healih Research and Policy Analysis Center
Assesses the financial mportance of the Sole Community Hospital (SCH)

program by. tho proportion of SCH that was roimbursed al the hospital Last Name
specifc rate between 2006 and 2015; the profitablty of roviding services

o Medicare patients in SCHs befween 2006 and 2015, and; the financial

consequences if the SCH program had not exsted in 2015 Email

First Name

* Medicare Accountable Care Organizations: Quality Performance by
the quality measures among the Medicare Shared Saving Program (MSSP)
'ACOs with varying levels of rural presence. Findings suggest that ACOs
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Subseribe to Research Alerts

Sign-up 1o receive email nofifcations
when new research products are

Research Alerts Rural Healn Research Gateva

Alerts

Rural Health Research Gateway

Promotion The Rural Health Research Alert email provides periodic updates when now.
publications become avalable. Alerts are available by email and posted on our

completed.
Facebook and Twitter accounts
First Name
Recent Updates
« December 22, 2016
Eree Webinar January 11! Obstetric Care Quality and Access for Rural US, ~ LastName
Women
« December 1,201
Medicare afions: Qualty Performance b Email

Geographic Categories

« November 30, 2016
Spread of Accountable Care Organizations in Rural America

 November 29, 2016
The Financial Importance of the Sole Community Hospital Payment
Designation

« November 28, 2016
The Impact of the Low Volume Hospital (LVH) Program on the Viabilty of e

Small, Rural Hospitals

Tweets o o
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Upcoming and Archived
Webinars

Rural Health Research Gateway
Webinars

Upcoming Webinars
 Ups and D ildren toCare
Thursday, October 13, 2016
Jan Probst, PhD, Professor, University of Soulh Caroing, and Diretor of
ihe South Carolia Rural Healt Research Cenler il present indings from
astudy based on the Natonal Surveys of Chidren's Healh.For many
42007, bt

ipped sighly n 20112012

Archived Webinars

+ Geographic Variation in Health Insurance Marketplaces: Rural and
Urban Trends in Enrollment, Firm Participation, Premiums. and Cost
Sharing in 2016 ‘Subse
Presented Tuesday, August , 2016
Tmothy McBride, PhD,aong vih Abiai Baer, P at e RUPRI

Sign-up o receive email nolications

Center for HiM products are
performance n ruralareas along several dimensions. They will provide completed
conlext

First Name

g postectcones o corsrers and o e govermen, olowed
by policy recommendations and QA

+ Exploring Rural and Urban Mortality Differences
Presented Wednesday, Jure 3, 2016
‘Alana Knudson, PD, from the North Dakota and NORC Rural Health
Reform Policy Resaarch Center, wil provide an overview of indings from
the recenty released study, Exploring Rural end Uban Mortaly Email
Differences. This sludy examines the impact o ruaily on mortalty and
explores regional diffeences in mortally rates.

Last Name.

+ Impact of the CMS Value-
et Proars on R Hosptals

Presented T

Research Products

* Policy Brief

¢ Fact Sheet

¢ Full Report/Working Paper

¢ Journal Publication

¢ Chartbook

* PowerPoint Slide Presentation
* Poster Presentation

¢ Infographic

¢ Promotional Products
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Rural Health Research & Policy Centers
R Fot Ot o o ok

Community Factors and Outcomes of Home Health Care for High-Risk Rural Medicare Beneficiaries

utcomes of care varied by region of the country for ural Figh ik condt rction, heart fll
preumon Rural

an ighr rte of el eadision and emergeney depariment use, Rural boneidres mwzmna,mmmam st North Cantal, and va(mn(eﬂwsDMsmnsnad fher rates of
being a0 o e comminity and over es o ot rednson g ral beneficiares”

regon i or
e, 250 valabiy o o e fsoees

Contact Information:

VTN Rl Health Rsearch Center
Phone: 206.598.5395.
tmrozQuwedu

‘Additional Resources of Interest:

the wwamL

‘Disparities topic Quides
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Dissemination of Rural Health
Research: A Toolkit

* Developed in April, 2015

* Assist researchers/authors with reaching intended
audiences

¢ Addresses

Rural He,

Re alth

* Dissemination products 2earch Gatews,
* Writing elements A Toolkiy

* Modes of dissemination

https://www.ruralhealthresearch.org/toolkit -
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Fact Sheet . Center or Rural Healch

kot on Fact Sheet
Ch istics of US and i Medical
Graduates in Primary Care Physicians in North Dakota

This fact sheet is Number 12 in 2 seies of anlyses regarcing physicians in North Dkota
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Topic Selection

What do you plan to write about?
* Research results
* Best practices
* Evaluation
* Research method
* Lessons learned
* Advertisement
* Announcement

Research Products

* Policy Brief

¢ Fact Sheet

¢ Full Report/Working Paper

¢ Journal Publication

¢ Chartbook

* PowerPoint Slide Presentation
* Poster Presentation

¢ Infographic

¢ Promotional Products

Journal Articles

Journals look for innovative and original research that will either
impact patient care or add to the field of study

* Active voice & third person
* Report findings clearly and concisely
* Typical outline: ,

* Introduction "
,::;f; and Alljeq Dental sy,
; mroda 's and P(-!ceptinns nfl;lze'lls'/‘“if"des |

Educatig,
2 "aprofession,) |

* Results
* Discussion & Conclusion
* Acknowledgements

* References

Audience

* Who?

* Engage in the development of the topic

* How do they consume information?

* Consider more than one audience
o More than one product

* Time considerations

¢ How do you want your information to be used:
o Citied
o Applied

Journal Articles

* Audiences vary
* Qualitative, quantitative, and mixed methods
* Journal rigor

* Urgency of publication International Journal of Emergency
. Mental Health and Human
* Get to know the journal Resilience

emationalJournal of Collaborative (7
sefrch oniternal Medicine & Public Health |\
. N

THE JOURNAL OF

The Online

Journal of Issues
in Nursing CANADIAN JOURNAL OF
INFECTIOUS DISEASES &
MEDICAL MICROBIOLOGY

Press Release

* Tailor press release to meet needs of media outlets
* Professional assistance

* Focus on facts

* Send to several local/state/national news outlets

* Plain language

* Early in the day/week

* One page

* Pyramid Style




Press Release

e First paragraph: who, what, when, where, why

¢ Share easy to understand data to support message
* Quote an expert

* Grab attention with a good headline

* Be prepared to give an interview

Social Media

¢ Make sure you have time to maintain
* Be aware of target population

* Make content easy to share

* Interact with end users

* Write in active voice

* No acronyms

* Post frequently

* Images and videos

Fact Sheet

* One page document - provides basic information
and important facts on a specific topic or issue

* simple and easy to understand

* an audience with very little time and outside of the
discipline

* Keep text brief

* Do not include details of study methods or
statistical significance

* Readers are interested in the facts, not where they
came from

Promotional

¢ Askintended audience
* Provide content — leave design to professionals
¢ Include only relevant information

¢ Include information not quickly outdated

* Contact information is last
* Include a call to action

* Make it accessible

e Flyer > Brochure

Posters

¢ Limit the focus of the poster and provide
supplemental resources as needed

e Use graphics to tell the story as much as possible,
but only graphics that have a purpose

e Hire a graphic designer if possible

* Do not make the poster dense with text; average
viewing time is between 3 and 5 minutes

¢ Create clear sections with spacing and headers

July 2016

Fact Sheet

ruralhealth.und.cdu
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Policy Brief

* Offer research findings and evidence informed
policy options in a synthesized, neutral, and user-
friendly format to a non-specialized audience

* Short, succinct, and easily accessible information

* Focus on a single topic

* No more than 4-6 pages

* Briefs are more likely to be read if they are
attractive, interesting, short, and easy to read

* Format: key findings, introduction, methods,
findings, conclusions, implications

What What We
Us Healthy On Being Healthy

<

GENETICS 20%

[ENVIRONMENT:20%

SERVICES

Activity

Infographics

* Visual explanations of data, information, or
knowledge

¢ Final product will clearly present complex
information/data/findings and be easy to consume

e Work with graphic designer — data visualization
specialist

* Do not make it too complex

* Make it easy to share

e Colorful, lively, shocking, and educational

Why just one?

* If time and resources permit, do not provide just
one product
* Oral Health Example

o Flyer on the Oral Health Research Project

o Chartbook with all frequencies from survey of long term care

o Fact sheet on aging population’s oral health status

o Journal article on the rural/urban comparison from the same
survey of long term care

o Press release when the survey was completed and chartbook
was available online

o Shared Figures and the link to the resource on social media

The Rural Health Research Gateway provides access to all publications and projects from seven
different research centers. Visit our website for more information.

www.ruralhealthresearch.org

Sign up for our email or RSS alerts!

www.ruralhealthresearch.org/alerts
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Grammar Check in Word

Turn the automatic spelling and grammar checker on or off

If you don't want Word to mark potential errors with squiggly lines while you are working, you can tum
automatic spelling and grammar checking off:

Open the spelling and grammar options:

= In OneNote, PowerPoint, Publizher, Visic, and Word: On the File menu, click Options, and then click Proofing

= InInfoPath: On the Home tab, click the arrow next to or under Spelling, and then click Spelling Options.

= InOutlook: On the File menu, click Options, and click Mail, and then ciick Spelling and Autocorrect.

Select or clear the Check spelling as you type check box. In some programs, you may also select or
clear the Mark grammar errors as you type check box.

When correc

ing spelling and grammar

S check speling s you type
2 Mark grammar errors az you type

¥ Frequently confused words

] Check grammar with speling

Show readability statistics

with or for al

checker on or
he Exceptions for

NOTE: In Word, yo

Hide spelling

cument E
errors in this document only and Hide grammar errors in this document only check boxes.

th ticle/C Ottice-20.

Reading Level in Word for Mac

Word uses the Flesch Reading Ease scale to indicate the relative complexity of written text. This system uses
an analysis that is based on the average number of syllables per word and words per sentence. Higher scores
correspond to text that is easier to understand, and lower scores correspond to text that is more difficult to
understand. Most documents should have a score between 60 and 70

1. On the Word menu, click Preferences.

rd Preferenc:

you must have a document open.

~

Under Authering and Proofing Tools, click Spelling and Grammar.

Under Grammar, select the Check grammar with spelling check box.

»

Select the Show readability statistics check box, and then click OK.

On the Tools menu, click Spelling and Grammar.

After Word finishes checking spelling and grammar, it displays information about the reading level of the

document.

to check rammar of text in other la and a document contains text in multple

lays readability statstics only for textin the last language that you check. For example, if

phs — the first in Spanish, the second in French, and the third in English — Wo

contains three parag

or the h text only

Reading Level in Word for PC

Word

1. Click the File tab, and then click Options.

2. Click Proofing.

3. Under When correcting spelling and grammar in Word, make sure the Check grammar with spelling
check box is selected.

4. Select Show readability statistics.

After you enable this feature, open a file that you want to check, and check the spelling. When Outlook or
Word finishes checking the spelling and grammar, it displays information about the reading level of the
document.

hi rt.office.com/en-US/articl your-d dability-85b4969e-e80a-4777-8dd3-f7fc3c8b3fd2

Understand readability scores

Each readability test bases its rating on the average number of syllables per word and words per sentence.
The following sections explain how each test scores your file's readability.

Flesch Reading Ease test

This test rates text on a 100-point scale. The higher the score, the easier it is to understand the document.
For most standard files, you want the score to be between 60 and 70.

‘The formula for the Flesch Reading Ease score is:
206.835 - (1.015 x ASL) - (84.6 x ASW)

where:

ASL = average sentence length (the number of words divided by the number of sentences)

ASW = average number of syllables per word (the number of syllables divided by the number of words)

Flesch-Kincaid Grade Level test

This test rates text on a U.S. school grade level. For example, a score of 8,0 means that an eighth grader can
understand the document. For most documents, aim for a score of approximately 7.0 to 8.0.

The formula for the Flesch-Kincaid Grade Level score is:
(.39 x ASL) + (11.8 x ASW) - 15.59

where:

ASL = average sentence length (the number of words divided by the number of sentences)

ASW = average number of syllables per word (the number of syllables divided by the number of words)




